Week g

3vd Grade Distance Learning One Pager

Turning in Work

Due: Every Monday by 6:30 PM

Please take a picture / scan the assigned TURN IN PAGE and send to the content teacher via
email, dojo, text, or remind. :

Reading: Ms. Brown Writing: Mrs. Bonds
Math: Mrs. Stence

Pick Up
Monday & Tuesday 7:00 AM-5:00 PM

You may access all 3™ grade distance learning materials on the IDEA Judson Academy
website: www.judsonacademy.wixsite.com/jags

Zoom Password: Idea

Teacher Contact Information

Ms. Brown- Reading Office Hours: Mon. &Wed. 9:00-10:00 AM
Zoom link: https:/zoom.us/j/7591902367
Phone: (305)397.5476
Email:Melissa.brown(wideapublicschools.org,
Mrs. Bonds- Writing Office Hours: Tues & Thurs 2:00pm-3:00PM
Zoom link: https://zoom.us/{/4630723113
Phone: 210.802.8445
Email:Kimberly.bonds(wideapublicschools.org

Mrs. Stence- Math Office Hours: Mon. & Wed. 1:00pm-2:00PM
Zoom Link: https://zoom.us/i/5079547980
Phone: 210.390.6340
Email:Katelynn.osburnstenc(a id eapublicschools.oro
Ms. Baldazula- Social Studies/ Office Hours: Tues & Thurs 1:00- 2:00PM
Intervention Zoom link: https://zoom.us/{/2467397250

Phone: 210.802.7036
Email: samantha.bazalduaiideapublicschools.oro

Mrs. Keeler- Special Education Office Hours M-F 1:00-2:00pm
(Sped) Zoom: https://zoom.us/|/554143817
Phone: 210.854.4644

Email: ruth.keeler@ideapublicschools.org

Please remember that teachers can be reached M-F via email, phone, remind
or dojo.
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3 Grade Weekly “Homework” Week 8

Day & Subject Task
Monday Reading:
Reading & Math e Read the poem titled 4 View from A Backpack.
e Answer questions 1-9.
Math:
e Pages1-2
Tuesday Writing:
Writing Create your own fun story
Author’s Chair
Wednesday- Reading:
Reading & Math e Read the poem Story

e Answer Comprehension Questions 1-10
Math:

e Pages3-4
** Students only need to return Page 4 this week**

Thursday- Writing &
Social Studies

Writing:
Journal Writing Time (Daily Prompts)
Social Studies:

Friday-
Electives/ Fun Friday

PE

AR/ Hotspot

Fun Friday: Virtual Field Trip to the San Diego Zoo
11-11:30 AM
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3rd — 5th Grade FITNESS FUN!
May 11 - May 15

My Goal: Complete two rounds of each exercise every day. Once each activity is complete,
mark with an “X”
Monday Wednesday Friday

10 Star Jumps

30 sec Planks

10 Squats Jumps

10 Half Jacks

10 Push Ups

10 Front to Back

10 Side to Side

10 Butterfly Kicks

30 sec Running in Place
Play Outside: 15-30 min

Below are examples of each exercise workout scholars will complete.

Star Jumps Plank Squat Jumps
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Half Jacks Push Ups Modified Push Ups

B slamy stock photo
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3" grade Poetry Quick Check #3

3RD Grade Reading/ ELA
Week 8 One Pager

Please turn in Answer Sheet for this week’s graded assignment.

Day Assignment

e Read the poem titled 4 View from
Monday- Week 8 Day 1 A Backpack.

e Answer questions 1-9.

e Read the poem Story
Answer Comprehension Questions
1-10
¢ Fill-in the answers on the sheet
i Wednesday- Week 8 Day 2 titled “Answer Sheet”. Take a
' picture of the answer sheet
ONLY and submit it via email,
remind, or dojo to Ms. Brown.

Additional Resources:

Please check out storyworks. Scholars can read different articles from a collection of
magazines! Follow the steps below to access storyworks.

1. Go to https://storyworks.scholastic.com/
2. Click the log-in button and select student
3. Enter the following passcode: Idea2020

Poetry Sites:

Interested in reading more poetry check out the following sites!

https://www.poetry4kids.com/

http://www.shelsilverstein.com/

https://poets.org/

https://www.poetryfoundation.org/learn/children

Need help with thyming words? Visit https://www.rhymezone.com/

Reading Week 8 Day 1
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3" grade Poetry Quick Check #3

A View from a Backpack
By Elizabeth Massie

My home is at the bottom of a zippered canvas sack
That Bobby MacAdoodle takes to school upon his back.
He put me in here long ago when school began in fall,

And here I stay, since that first day, all wadded in a ball.
I am a piece of paper that Bobby used in class

To write a poem about a cricket hopping through the grass.

But he changed his mind and wrote of baseball games instead.

Into the backpack I went, landing crumpled on my head.

I’m not complaining that I feel alone or lost or even mad,

For I have lots of buddies, so I’m never really sad.

We keep each other company, a bunch of odds and ends,

And sometimes Bobby tosses in another couple friends.

There are three paper clips that Bobby dropped in one day,

An ink pen cap, a pencil lead, erasers—white and gray,

A lunch bag with some slimy stuff, some chocolate crumbs and glue,

Some string, some lint, a homework pad, a sandwich turning blue.

Bobby opens up his backpack when he needs to get a book.

But rarely does he dig down deep or try to take a look

But one spring day, oh say in May or maybe early June,

When flower blossoms scent the air and bluebirds sing their tune,
School will let out and home we’ll go for good, my friends and I.
Bobby then will dump us out and at last we’ll see the sky.

Pens, pencils, and the glue will find a home upon a shelf.

That blue sandwich and its slimy bag—well, just ask yourself.

Notebooks and those paper clips straight on to the desk they’ll go.

Then Bobby’s mom will find my poem, and frame me just for show!




3" grade Poetry Quick Check #3

1. This poem is told from the perspective, or point of view of ...
A. Bobby
B. a backpack
C. Bobby's mother
D. a piece of paper
2. This poem mostly takes place-
A. in a field
B. on a shelf
C. ata school
D. in abackpack
3. This poem has the following rhyme scheme-
A. every other line rhymes
B. every pair of lines rhyme
C. free verse
D. no rhyming pattern is present

4. In the poem, the author writes about when “flower blossoms scent the air.”
This sensory language draws upon the reader’s sense of:
A. sight
B. touch
C. smell
D. sound

6. Which words rhyme in each stanza of the poem?

A. The last words in the second and fourth lines

B. The last words in the first and second lines



3 grade Poetry Quick Check #3

C. The last words in the first and third lines

D. The last word in every line

7. According to the poem, what season will it be when the items get out of the
backpack?

A. fall
B. spring
C. summer
D. winter
8. What is the message of this poem?
A. Things have a way of working themselves out.
B. A backpack is a horrible, smelly place.
C. Parents want their kids to get good grades.
D. Students should try to be organized.
9. Who are the friends from the backpack?
A. Bobby and his best friend from school
B. The paper, ink pen cap, pencil lead and erasers
C. The mom and her girlfriends

D. Basketballs from gym class



3" grade Poetry Quick Check #3

Reading
Week 8, Day 2

Focus: Poetry Elements
Skills: Author’s Craft, Imagery, Descriptive Details, Poetry Elements
Complete the passage and remember to show all strategies

Number lines and stanzas
Identify the rhyming words
Identify the rhyme scheme
Look for Sensory Details

O 00O



3 grade Poetry Quick Check #3

Name: ~ Date:

Reading Week 8 Day 2

Story

By: Eloise Green

| step into the story.

| leave my world behind.

| let the walls of the story

be the walls around my mind!

New faces and new voices.

I listen and | see.

and people | have never met
mean everything to me.

| worry when they worry.

| qguake when danger’s near.

| hold my breath and hope

that all their troubles disappear.

| don’t know what will happen.
I never know what I'll find.
When | step into a story

and leave my world behind.

1. Which of the following phrases BEST states the topic of this poem?
A. The reader gets bored by reading.
B. The reader gets caught up in the stories that books offer.
C. The reader literally builds a house out of books.
D. The reader thinks books are dangerous.
2. Who are the “people” in stanza 27
A. some friends from school
B. relatives and family members
C. the characters from the story

D. people from the book store



3" grade Poetry Quick Check #3

3. What does the word gquake mean in the third stanza?
A. to shake or tremble
B. to run fast
C. to play nearby
D. to be calm
4. What is the theme of this poem?
A. Real books will soon disappear.
B. Hard work pays off.
C. Stories can be an adventure.
D. Books are fun to share with friends.
5. What is the speaker doing in this poem?
A. reading a book
B. dreaming
C. discussing his opinion
D. playing outside

6. Read lines 1 and 2 from the poem.

| step into the story.
| leave my world behind.

The poet uses these lines to show that the speaker is —
A. enjoying the story
B. not wanting to get involved
C. feeling upset
D

. packing to go on a trip



34 grade Poetry Quick Check #3

7. Which of these lines from the poem rhyme?
A. Lines 1 and 2 in each stanza
B. Lines 2 and 4 in each stanza
C. Lines 3 and 4 in each stanza
D. Lines 2 and 3 in each stanza
8. How does the speaker feel about books in the poem?

A. He deeply dislikes books.

B. He does not believe anything he reads.

C. He feels like they are an adventure.

D. He feels sad about the events from the stories.

9. This poem is written in which point of view?

A. third person

B. second person

C. first person

D. none of these
10. The poem is entitled “Story” because —
It is a poem about stories

It is a poem about a poem

It is a poem about a dramatic play

oo w>»

It is a poem about informational text



3 grade Poetry Quick Check #3

Name: Date:

Please submit this Page ONLY!

Directions: Use this sheet to record your answers for each day. Only write the letter that you
circled for each question. Record answers for each day below (Letter Only). Take a picture of

the answer sheet ONLY and submit it via email. remind. or dojo to Ms. Brown.

Day 2: Wednesday
Answers (Letter Only)
1.

2.

10.




Grade 3- Math
Module 5- Week 8

Suggested Schedule:
o Monday 5/11- Pgs. 1-2
o Wednesday 5/13- Pgs. 3-4

Please feel free to complete the work at the schedule and
pacing that works best for your family's schedules to allow
them to complete the work by May 18th

Students only need to return page 4 this week

Questions?
IDEA Judson YouTube Channel: https://
www.youtube.com/channel/UC55]24gTdnm5_adXoPfW68Q/

playlists

Office Hours: Mondays & Wednesdays, 1:00-2:00

Password: Idea

Zoom: https://zoom.us/j/5079547980

Email: katelynn.osburnstenc@ideapublicschools.org

Phone: (210) 390- 6340
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¢ Fast | Focus™ Standard 5A / Page 2

1 Ariana drew the model below.
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The model best represents —
A 231 +115 =346
B 231-105=126
C 116 + 115 = 231

D 231 -115=116

2 Brandon drew the model below.

1 1 1

4

6 8 10 12 14 16 18 20

The model best represents —
F 20-12-8=8
G20+12+8=40
H20-8-4=8
J 20+8+4=32

3 Takiyah had $20 before she bought the lunch
items shown in the table below.

Sandwich $7
Salad $3
Fruit Juice $2

Which equation can be used to find how much
money she had after she bought the 3 items?

A 20-3=0

B7+3+2-20=0
C 20-7-3-2=0
D7+3+2+20=0

o e o o e o o o e m e o o e e e e o e 2 A v 2 b o e A " . = o o i . i i o o e e B e 2 e e A T T o e e e S e i e

1 Fabian has 15 coins in one jar and 9 coins in
another jar. He will give Logan 3 coins. Which
model represents the number of coins that Fabian
will have left?

The model best represents —
F 5 plus 10 minus 2
G 5 plus 10 minus 8

H 5 plus 8 minus 2
J 5 plus 5 minus 2

3 Emily borrowed $18 from Marta. Emily will pay
her back 7 dollars on Thursday and 4 dollars on
Friday. She will pay her the rest of the money on
Saturday. Which equation can be used to find the
number of dollars that Emily will pay Marta on
Saturday?

A18-7-4=00 C7+4=0
B18+7-4=0 D7-4=0

1

==
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Standard 5A / Page 3 ¥ Fast | Focus'"*

Standard 5A / Page 4

1 Which model represents 10 + 6 — 47
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2 Which model represents 8 + 4 - §?
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3 On his birthday, Bryan received $20 from his
aunts and $30 from his uncles. After Bryan’s
parents gave him some money, he had $90 total.
Which equation can be used to find the amount of
money Bryan’s parents gave him?
A 20+30=0 C9+20-30=0
B20+30+90=0 D90-20-30=0

- —— - 8 A A e A M A W L L A R e e e e e e S R e A e e e e  ——

1 Nikita jogged 12 miles last month. Gabriella
jogged 2 more miles than Nikita. Which equation
can be used to find the number of miles that Nikita
and Gabriella jogged combined?

A12+12+2=0
B12+2=0
CcC12+12-2=0
D12-2=0

2 Chase has 16 baseball cards. He will buy 8
more cards on Tuesday and 12 more cards on
Wednesday. Which model represents the total
number of cards Chase will have?

0 4 8 12 16 20 24 28 32 36 40
Rl Wl Y

8 12 16 20 24 28 32 36 40
H /\/\/\
4 8 12 16 20 24 28 32 36 40
J’///ffi:::::k\
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4
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0 8 12 16 20 24 28 32 36 40

3 Vivian bought a new book on Saturday. She
read 112 pages on Saturday night and 96 pages
on Sunday. The book has 365 pages. Which
equation can be used to find the number of pages
that Vivian needs to read to finish the book?

A 365+112-96=0
B 365-112-96=0
C 365-112+96=0
D 365+112+96=0

2
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Standard 5A / Page 6

1 Two chipmunks gathered 72 nuts in a meadow
and 56 nuts in a forest. The chipmunks stored all
of the nuts except 16. Which equation can be
used to find the number of nuts that the
chipmunks stored?
A72-56-16=0
B72+56-16=0
C72-56=0
D72-16=0

2 Look at the model below.
-4—
0 2 4 6 & 1012 14 16 18 20
The model best represents —
F14-2-2 H14-12-10
G14+2+2 J 14+2-2

1 i i i 1

3 Miranda baked 45 cookies. She gave 25 to her
friends and 10 to her teacher. Which model
represents the number of cookies that Miranda
had left?

0 5 10 15 20 25 30 35 40 45 50

0 5 10 15 20 25 30 35 40 45 50

0 5 10 15 20 25 30 35 40 45 50

.-4-------..____-..--..-----_-__\____-_-_--------—4-_<-__—--‘------------__-a-—-__-__-.._-.-_‘_'_-_".-.'-_a-‘_'-_-____________‘....-_...-_ - —— - -

1 Samuel wants to buy the items shown on the list
below.

Rocket kit........... $13
Extra engines....... $5
Extra parachute....$2

Samuel has $25. Which equation can he use to
find how much money he will have left if he buys
the three items?

A13+5+2=0

B25+13+565+2=0
C25-13-5-2=0
D25-13+5+2=0

2 Mingmei drew the model below.

1 i L
r v v

0 3 6

9 12 15 18 21 24 27 30

The model best represents —
F 24-15-9=9
G24-3-2=9
H24-9-6=9
J 24-9+6=9

3 Derrick drew the model below.

D o 00 O
o o o
B 6 . 0

B O Wl 5

R

The model best represents —
A 223-215=8
B 225-212=13
C 221-214=7
D 227 -216 =11

3
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3% Fast Focus™ Standard 5B / Page 1

s%Fast Focus™ Standard 5B / Page 2

1 Keith bought 6 large melons and 1 small melon.
He paid $4 for each large melon. He paid $2 for
the small melon. Which equation can be used to
find the total cost of the melons?

A6+4+2=0
B6-4-2=0
C6x4+2=0
D6x4x2=0

2 Amelia’s jewelry box has 6 drawers. She keeps
8 pieces of jewelry in each drawer. Which model
best represents the total number of pieces of
jewelry in the jewelry box?

F

Total pieces

6 6

Total pieces

8 8

Total pieces

Total pieces

8

8

3 A coach divided Zalman and 15 other players
into 2 equal groups. After a few minutes, Zalman
left the first group and joined the second group.
Which number sentence represents the number of
players that were left in the first group?

A16+2-1=7 C€C16-2-1=13
B16x2-1=31 D16+2+1=9

Please return this page to Mrs. Stence :)

e Q=g =g =g ey g g g e g S o

1 Audrey bought 3 packs of gum. There were 6
sticks of gum in each pack. She opened the packs
and gave 8 sticks of gum to Devin. Which model
best represents the number of sticks of gum that
Audrey had left?

A 8 8 8
24
8 Audrey (16)
5 3 6 8
17
8 Audrey (9)
c 8 8 8
24
8 8 Audrey (8)
D 6 6 6
18
8 Audrey (10)

2 Gustavo drew the model below to help him
solve a math problem.
ol o

[g o]]@ o © 0llo

0)J®© © © 0)|©

cosdle oJole

Which number sentence does the model
represent?

F54+9=6 H36+4=9
G32+4=8 J 27+3=7

4
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Writing: Journal Time

Jaguar Family, here are the steps for writing the week of 5-11-20 to 5-
15-20. See the newsletter on the back of this page for the writing
prompt each day. **Please scan/take a picture of the writing for 5-15-
20 ONLY** Please advise your scholar that they should be writing daily
because | will choose one writing prompt each week that | will grade.
There is a fun story sheet your scholar can use to do the writing prompt
for 5-15-20 (enclosed in the packet). During Zoom time | will have
scholars share their writing with their classmates and me. Please make
sure your scholars are responding to the prompt, writing neatly and
clear, putting their name where it is visible for me to see. Remember to
scan only 5-15-20 writing prompt to me on Remind, Dojo or my email,
it is due no later than 5-18-20. If you have any questions, please reach
out to me.

Writing Prompt Steps:

e Welcome to Journal time.

e Today you are going to take 30 minutes to brainstorm to write
and share about a topic | give you.

e For the first 5 minutes you are going to brainstorm all the ideas
that you can think of.

e Make sure it’s related to the topic.

e Once you choose the best idea, you're going to take the next 20
minutes to write about the idea that you have selected.

e If you feel like you are finished, go back in your story and revise
and edit and look for mistakes.

e If you still have time after that, select a new idea from your list
and continue writing.

e Forthe last 5 minutes, you can share your writing with someone
at home.



Idea Judson Academy
3rd Grade Writing

Jag News

Writing Time

The purpose of a newsletter is to provide information on how
the next few weeks of distance learning will look. Your scholar
can use the lined paper in the packet to respond to the writing
prompts daily. Remember I am only requesting one writ-
ing prompt per week to be turned in so please do not
scan/take a picture of every writing prompt. The writing
prompt is still due by the following Monday (Turn in the
writing prompt for 5-15-20) but feel free to scan/take a pic-
ture early if your scholar has completed the prompt.

Writing Prompts:
5-11-20: Write about an idea for an invention.

5-12-20: Write from a point of view from an insect.

' 5-13-20: Create a story about being quarantined during Covid-19

5-14-20: Write a story that starts with a scream.

5-15-20: Write about The Best Day Ever (see attachment to
guide your scholars).

*Scholars can use their journal or lined paper to respond to
the prompts daily*

P

‘Writing for Week 5-11-20 to 5-15-
20

Y S

i,

*Writing Directions ‘
¢ Writing Prompts for two weeks!
» Judson Website I
eZoom code: ldea ‘

Special Reminders:

Start each sentence with a capital letter,
(My favorite food is shrimp.)

Grab your readers attention (strong
introduction)

Use correct punctuation marks.(., ? “1}

» Remember to use interesting words.

(gigantic, bold, strong)
Check your spelling. |

Closing Sentence (wrap it up, don’t |
leave your reader hanging).

‘Write in your best handwriting.

Make sure you are writing at least 5
sentences or more.

HAVE FUN!!!
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The Case of the Missing

* Special Noun *

There once was a detective named . One day, the

Name

detective's neighbor knocked on the door.

"l am so ," said the neighbor. "l can't find my

Adjective * Special Noun *

anywhere. | saw it before | went to club, but later it was gone!”

Verb ending in "ing"

The detective grabbed a pencil and a __and asked, "Will

you describe it?"

"Certainly," said the neighbor. "It is , and

Adjective

it never

Plural verb

The detective searched around every

behind every

Noun

I" said the detective, "l found it! It was right here under

Exclamation

your the whole time!"

Noun

They both had a good , and the detective thought,

Verb

"Another case solved!”

Adverb




The Best Day Ever

One day | woke up feeling © , and | knew

Emotion

it was going to be a special day. The sky was ®

Color
and the weather was & , so | hopped out of
Weather
bed, put on my L and my
Article of clothing Adjective
= , and | was ready to
Type of footwear Verb
Outside, | caught the first #9 , which took
Type of vehicle
| @ P f
me straight into & . I went #®
Town/City Direction
until | came to a store selling _ ,
Adjective Plural noun
where | bought the perfect !
Adjective Noun
Next, | treated myself toa ¥ snack at a
| Type of food
|
| v restaurant. It was very & ,
Type of food Temperature
. but it was still good enough to
; Verb
Finally, | went back home. | fed the ,
| Animals
%
; then sat down on the = , and thought, "What
Piece of furniture
| a/an day!”

| i Adjective




Story Title

Ready to create your own Funny Fill-in story? To get
started right away, just replace this text with your own. You
can customize your story by adding your own pictures,
shapes, and icons. On the Insert tab of the ribbon, just tap
the option you need.

Once your story is complete, go back and replace the
nouns, adjectives, adverbs, and other words with fill-in
blanks. To create the fill-in blanks, just add a series of
underscores, like this:

To add the labels, at the end of each line of your
story, press Enter twice to create an empty paragraph
between each line. Type the label text, and then select the
Fill-In-Label style from the Styles gallery on the Home tab.
Use tabs and spaces in front of the label to position it under
the fill-in blank:

Fill-In Label

Get creative with your fill-in labels by using an lcon
from the Insert tab in place of the label text. Resize and
recolor the icons on the Format tab, and then select the
Fill-In Icon style for the label paragraph:

Stuck for story ideas? Get inspiration from a favorite
story, fairytale, song, movie, or show. For a special
occasion, such as a birthday or family get-together, write a
story about the person or a funny family story.




